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PhÇn 1: Lμm quen víi phÇn mÒm ArcGIS 
 

Giíi thiÖu phÇn mÒm ArcGIS 

         Arcgis Desktop lµ g×? 

Arcgis Desktop lµ mét s¶n phÈm cña ViÖn Nghiªn cøu hÖ thèng m«i tr−êng 

(ESRI) . Cã thÓ nãi ®©y lµ mét phÇn mÒm vÒ Gis hoµn thiÖn nhÊt.  Arcgis cho 

phÐp ng−êi sö dông thùc hiÖn nh÷ng chøc n¨ng cña Gis ë bÊt cø n¬i nµo hä 

muèn: trªn mµn h×nh, m¸y chñ, trªn web, trªn c¸c field … PhÇn mÒm  Arcgis 

Desktop bao gåm 3 øng dông chÝnh sau:  

 

 
 

 ArcMap 

- ArcMap ®Ó x©y dùng, hiÓn thÞ, xö lý vµ ph©n tÝch c¸c b¶n ®å. 

 + t¹o c¸c b¶n ®å tõ c¸c rÊt nhiÒu c¸c lo¹i d÷ liÖu kh¸c nhau 

 + truy vÊn d÷ liÖu kh«ng gian ®Ó t×m kiÕm vµ hiÓu mèi liªn hÖ gi÷a 

c¸c ®èi t−îng kh«ng gian 

 + t¹o c¸c biÓu ®å  

 + hiÓn thÞ trang in Ên 

 ArcCatolog 

- ArcCatalog: dïng ®Ó l−u tr÷, qu¶n lý  hoÆc t¹o míi c¸c d÷ liÖu ®Þa lý 
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  + t¹o míi mét c¬ së d÷ liÖu 

  + explore vµ t×m kiÕm d÷ liÖu 

  + x¸c ®Þnh hÖ thèng to¹ ®é cho c¬ së d÷ liÖu    

 ArcToolbox 

- ArcToolbox: cung cÊp c¸c c«ng cô ®Ó xö lý, xuÊt-nhËp c¸c d÷ liÖu tõ c¸c 

®Þnh d¹ng kh¸c nh− MapInfo, MicroStation, AutoCad… 

  Thùc hμnh më, hiÓn thÞ d÷ liÖu trong ArcGis 

KiÕn thøc nÒn: 

- Mçi mét b¶n ®å trong Arcmap ®−îc gäi lµ Map document, mét b¶n ®å cã 

thÓ cã mét hay nhiÒu data frames. Data Frame lµ mét nhãm c¸c líp (Data layer) 

cïng ®−îc hiÓn thÞ trong mét hÖ quy chiÕu. Mçi Data Frame cã thÓ cã mét hÖ quy 

chiÕu riªng. C¸c Data Frame ®−îc hiÓn thÞ riªng biÖt trong chÕ ®é Data View vµ 

cã thÓ hiÓn thÞ  trong cïng mét Layout View. Th«ng th−êng, mét b¶n ®å ®¬n gi¶n 

chØ cã mét Data Frame vµ b¹n cÇn sö dông nhiÒu Data Frame khi cÇn in thªm 

mét sè b¶n ®å phô trªn 1 m¶nh b¶n ®å chÝnh. B¶n ®å (Map document) ®−îc ghi 

trong file cã ®u«i lµ .mxd 
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 - ArcMap cã chøc n¨ng Project on-the-fly cho phÐp thay ®æi mét c¸ch 

nhanh chãng hÖ quy chiÕu cña c¸c Layer. VÝ dô nh− ta cã mét b¶n ®å trong hÖ 

to¹ ®é VN-2000 vµ nÕu ta thªm vµo b¶n ®å 1 líp ®−îc x¸c ®Þnh trong hÖ HN-72 

th× ArrcMap sÏ tù ®éng chuyÓn t¹m thêi líp ®ã vÒ hÖ VN-2000 ®Ó hiÓn thÞ ®óng 

trªn b¶n ®å cïng víi c¸c d÷ liÖu kh¸c. B¶n th©n c¸c tÖp tin chøa líp võa thªm 

vµo th× vÉn kh«ng thay ®æi, tøc lµ vÉn trong hÖ HN-72. 

- Layer lµ tæ hîp cÊp cao cña d÷ liÖu. Mét layer file chøa c¸c néi dung: 

 + ®−êng dÉn tíi d÷ liÖu (Shapefile, geodatabase..) 

 + c¸c tham sè ®Ó hiÓn thÞ nh− mµu s¾c, lùc nÐt ký hiÖu 

 - C¸c Layer cã thÓ ®−îc t¹o ra tõ nhiÒu nguån d÷ liÖu kh¸c nhau nh−: 

Shape files, personal geodatabase, ArcInfo cover datasets, CAD drawings, SDE 

databases, photo, image. 

- D÷ liÖu l−u tr÷ trong ArcGis ®−îc l−u tr÷ ë 3 d¹ng: shapefile, coverages, 

geodatabase. 

     + Shape files:  l−u tr÷ c¶ d÷ liÖu kh«ng gian lÉn d÷ liÖu thuéc tÝnh. Tuú 

thuéc vµo c¸c lo¹i ®èi t−îng kh«ng gian mµ nã l−u tr÷, Shape files sÏ ®−îc hiÓn 

thÞ trong ArcCatolog b»ng 1 trong 3 biÓu t−îng sau: 

        VÒ thùc chÊt shape file kh«ng ph¶i lµ 1 file 

mµ lµ 5-6 file cã tªn gièng nhau nh−ng ®u«i k¸ch 

nhau. 3 file quan trong nhÊt cña shape file lµ c¸c 

file cã ®u«i: 

 *.shp – chøa c¸c ®èi t−îng kh«ng gian (Geometry) 

 *.dbf – b¶ng thuéc tÝnh 

 *.shx – chØ sè ®Ó liªn kÕt ®èi t−îng víi b¶ng thuéc tÝnh 

 *.prj – x¸c ®Þnh hÖ quy chiÕu cña shape file 

+Coverages: l−u tr÷ c¸c d÷ liÖu kh«ng gian, thuéc tÝnh vµ topology. C¸c d÷ 

liÖu kh«ng gian ®−îc hiÓn thÞ ë d¹ng ®iÓm, ®−êng, vïng vµ ghi chó. 

 + GeoDatabase: lµ mét CSDL ®−îc chøa trong mét file cã ®u«i lµ *.mdb. 

Kh¸c víi shape file, GeoDatabase cho phÐp l−u gi÷ topology cña c¸c ®èi t−îng. 

Cêu tróc cña GeoDatabase nh− sau: 
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 Trong GeoDatabase cã 1 hay nhiÒu Feature Dataset. Feature Dataset lµ 

mét nhãm c¸c lo¹i ®èi t−îng cã chung mét hÖ quy chiÕu vµ hÖ to¹ ®é. Mét 

Feature Dataset cã thÓ chøa mét hay nhiÒu Feature class. Feature class chÝnh lµ 

®¬n vÞ chøa c¸c ®èi t−îng kh«ng gian cña b¶n ®å vµ t−¬ng ®−¬ng víi 1 layer 

trong Arcmap. Mçi Feature class chØ chøa mét ®èi t−îng ( polygon –vïng, line-

®−êng, point-®iÓm). Mét Feature class sÏ ®−îc g¾n víi 1 b¶ng thuéc tÝnh 

(Attribute Table). Khi b¹n t¹o Feature class th× b¶ng thuéc tÝnh còng ®−îc tù ®éng 

t¹o theo.  

Thùc hμnh më, hiÓn thÞ d÷ liÖu trong ArcGis 

 I. Lμm quen víi phÇn mÒm ArcMap 
C¸c chÕ ®é hiÓn thÞ 

ArcMap cung cÊp 2 chÕ ®é hiÓn thÞ: Data View vµ Layout View 

+ Data View hiÓn thÞ c¸c néi dung chÝnh cña b¶n ®å tøc lµ c¸c ®èi t−îng 

kh«ng gian 

+ Layout View: hiÓn thÞ b¶n ®å trong chÕ ®é nh− chóng ta in ra giÊy. Ngoµi 

c¸c ®èi t−îng b¶n ®å cßn hiÓn thÞ c¸c yÕu tè trang trÝ b¶n ®å nh− khung, l−íi to¹ 

®é,  chó gi¶i 

§Ó thay ®æi chÕ ®é hiÓn thÞ chän thanh thùc ®¬n View vµ chän chÕ ®é hiÓn thÞ 

1. Khëi ®éng Arcmap: chän menu Start > programs > ArcGIS > Arcmap  

HoÆc kÝch ®óp vµo biÓu t−îng    trªn mµn h×nh Desktop. 
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2. Trªn mµn h×nh xuÊt hiÖn hép tho¹i ArcMap,lùa chän ch−¬ng tr×nh lµm 

viÖc råi click Ok  

- A new empty map: t¹o mét b¶n ®å míi. 

- A template: më mÉu cã s½n 
-  An existing map: më mét b¶n ®å cò. §Ó 

chän ®−êng dÉn cho b¶n ®å ta chän Browse for 

maps. 

 

3.  §Æt c¸c tham sè cho Data Frame 

 Trong th− môc Table of contents (TOC) cña b¶n ®å võa t¹o cã 1 

Data frame cã tªn mÆc ®Þnh lµ 

Layers. Data Frame nµy hiÖn cßn 

®ang rçng: 

         §Æt hÖ thèng to¹ ®é cho DataFrame 

 BÊm chuét ph¶i vµo  råi 

trong menu hiÖn ra chän Properties 

 Trong hép tho¹i hiÖn ra bÊm vµo trang Coordinate System 

 Trong hép tho¹i Select a coordinate system chän 

Predefined> Geographic Coordinate 

Systems >World > WGS 1984 

 BÊm Apply. 

Tõ giê trë ®i b¶n ®å sÏ ®−îc hiÓn thÞ trong 

hÖ to¹ ®é ®Þa lý WGS-84. NÕu b¹n thªm vµo 

Data Frame (tøc lµ thªm vµo b¶n ®å c¸c d÷ liÖu 

trong hÖ quy chiÕu kh¸c) th× chóng sÏ ®−îc tù 

®éng chuyÓn ®æi vÒ hÖ WGS-84. §Ó ®æi tªn cho 

Data Frame Layers vµ chän ®¬n vÞ hiÓn thÞ täa 

®é cho nã lµm c¸c b−íc sau: 
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§æi tªn cho DataFrame 

 BÊm chuét ph¶i vµo  råi chän Properties 

 BÊm vµo trang General 

 Trong « Name gâ “WGS84” ®Ó ®æi tªn cña Data Frame 

 Trong « Display chän Degrees Minutes Seconds ®Ó hiÓn thÞ to¹ ®é 

d−íi d¹ng ®é-phót-gi©y. 

4. Thªm d÷ liÖu tõ Shape file vµ coverage file 

BÊm nót Add data  tõ thanh c«ng cô cña ArcMap hoÆc kÝch chuét ph¶i 

vµo Layer bªn b¶ng TOC chän Add Data. 

- chän ®−êng dÉn cho th− môc lµm viÖc 

- Ên phÝm Shift nÕu muèn chän ®ång thêi nhiÒu líp 

- BÊm Add 

5. T¹o mét Data Frame míi 

 Chän menu Insert > Data Frame   

  xuÊt hiÖn trong 

TOC. §Ó ý c¸c layer cña Data Frame WGS 84 kh«ng hiÓn thÞ trªn 

mµn h×nh n÷a (do trong chÕ ®é Data View, ArcMap chØ hiÓn thÞ 1 

Data Frame trong 1 thêi ®iÓm, ®ã lµ Active Frame – tªn cña nã ®−îc 

viÕt b»ng ch÷ ®Ëm trong TOC). Ta cã thÓ chon hÖ quy chiÕu k¸ch 

cho New Data Frame nµy. 

 §Ó t¾t New Data Frame cho bËt WGS84, trong TOC bÊm chuét ph¶i 

vµo data frame WGS84 råi chän Activate. New Data Frame sÏ t¾t ®i 

vµ trªn mµn h×nh sÏ hiÖn ra data frame WGS84 (ch÷ ®Ëm). 

 

 

 

 

 



http://www.ebook.edu.vn  7 

 Lμm quen víi c¸c c«ng cô trong ARCMap 
 Thay ®æi tû lÖ b¶n ®å vµ dÞch chuyÓn cöa sæ: 

C¸c c«ng cô ®Ó hiÓn thÞ b¶n ®å 

 
 

- Phãng to (Zoom in) vµ thu nhá (Zoom out). 

- Phãng to/ thu nhá theo t©m c¶u mµn h×nh (Centered zoom) 

- Phãng to hÕt cì (Full extent) vµ dÞch chuyÓn (Pan) 

  T¾t/bËt c¸c layer 

Trong khi xem mét b¶n ®å, b¹n cã thÓ sö dông chøc 

n¨ng bËt hay t¾t mét layer. Mét layer sÏ ®−îc t¾t ®i khi b¹n 

muèn thÓ hiÖn mét layer kh¸c hay b¶n ®å n»m ngoµi tû lÖ layer 

cho phÐp. 

                Layer ®ang ®−îc thÓ hiÖn trªn View  

                               Layer ®ang bÞ t¾t 
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 Xem c¸c th«ng tin thuéc tÝnh 

Mçi mét Layer ®Òu cã mét b¶ng thuéc tÝnh ®i kÌm ®Ó m« t¶ c¸c ®èi t−îng 

cña líp ®ã. §Ó xem th«ng tin thuéc tÝnh cña mét ®èi t−îng nµo ®ã ta cã thÓ më 

b¶ng Attribute Table hay dïng c«ng cô Identify 

 BÊm vµo c«ng cô Identify  

 BÊm chuét vµo ®èi t−îng cÇn hiÓn thÞ 

trªn b¶n ®å 

 KÕt qu¶n ®−îc hiÓn thÞ trong cöa sæ 

Identify results  

 Chän ®èi t−îng (Select a feature) 

Tr−íc khi lµm viÖc víi mét ®èi t−îng hay mét 

nhãm ®èi t−îng nµo ®ã ta cÇn ph¶i lùa chän chóng. 

§Ó chän ®èi t−îng ta cã thÓ sö dông c«ng cô Select a feature hay b»ng c¸c hái 

®¸p – query).  

 Vµo menu Selection > Set Selectable Layers   

 
 Tuú theo chÕ ®é chän ®−îc ®Æt trong menu Selection > Interactive 

Selection Method khi ta bÊm vµo ®èi t−îng nµo ®ã th× cã thÓ 

1) §−îc thªm vµo danh s¸ch c¸c ®èi t−îng ®· ®−îc chän 

2) Lo¹i khái danh s¸ch ®ã 

3) Trë thµnh ®èi t−îng ®−îc chän 

duy nhÊt. 

 
 

 

 



http://www.ebook.edu.vn  9 

 T×m c¸c ®èi t−îng ®· ®−îc chän 

Do mµn h×nh kh«ng thÓ hiÓn thÞ hÕt ®−îc toµn bé b¶n ®å nªn cã mét sè ®èi 

t−îng nµo ®ã tuy ®· ®−îc chän nh−ng bÞ khuÊt kh«ng nh×n thÊy ®−îc. §Ó hiÓn thÞ 

chóng ta dïng c«ng cô Zoomto Selected.  

Trong menu Selection > Zoom to Selected 

 
  Thay ®æi chÕ ®é hiÓn thÞ d÷ liÖu 

    1. Thay ®æi hiÓn thÞ cho vïng 

- kÝch chuét ph¶i vµo líp cÇn thay ®æi 

thuéc tÝnh chän Properties 

 - chän Symbology 

 - chän Unique value 

 - chän tr−êng cÇn thay ®æi ë hép tho¹i 

Value Field 

 - chän Add All Values 

 - kÝch ®óp chuét vµo ký hiÖu cÇn thay ®æi 

 - chän l¹i mµu s¾c, ®−êng viÒn cña vïng 

 - BÊm Apply 

 - BÊm OK 
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    2. Thay ®æi chÕ ®é hiÓn thÞ cho ®−êng 

- kÝch chuét ph¶i vµo líp cÇn thay ®æi 

thuéc tÝnh chän Properties 

 - chän Symbology 

 - chän Unique value 

 - chän tr−êng cÇn thay ®æi ë hép tho¹i 

Value Field 

 - chän Add All Values 

 - kÝch ®óp chuét vµo ®−êng cÇn thay ®æi 

 - chän l¹i mµu s¾c, lùc nÐt cña ®−êng 

 - BÊm Apply 

 - BÊm OK 

   3. Thay ®æi chÕ ®é hiÓn thÞ cho ®iÓm 

- kÝch chuét ph¶i vµo líp cÇn thay ®æi 

thuéc tÝnh chän Properties 

 - chän Symbology 

 - chän Unique value 

 - chän tr−êng cÇn thay ®æi ë hép tho¹i 

Value Field 

 - chän Add All Values 

 - kÝch ®óp chuét vµo ký hiÖu cÇn thay ®æi 

 - chän l¹i mµu s¾c, kÝch cì, h×nh d¹ng cña ®iÓm 

 - BÊm Apply 

 - BÊm OK 
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    4. G¸n nh·n 

 - kÝch chuét ph¶i vµo líp cÇn thay ®æi thuéc 

tÝnh chän Properties 

 - chän Label 

 - tÝch chuét vµo « Label features in this layer 

 - chän tr−êng trong hép tho¹i Text String 

 - chän ph«ng ch÷, ®é ®Ëm, mµu s¾c, kÝch cì 

ch÷ trong hép Text Symbol 

 - BÊm Apply 

 - BÊm OK 

 

 Më b¶ng thuéc tÝnh (Attribute table) 

Mçi mét líp cã mét b¶ng thuéc tÝnh liªn kÕt víi nã ®Ó m« t¶ c¸c ®èi t−îng 

trong líp ®. §Ó më mét b¶ng thuéc tÝnh ta lµm theo c¸c b−íc sau: 

 BËt líp layer ®ã b»ng c¸ch ®¸nh dÊu « vu«ng nhá c¹nh nã trong TOC 

 BÊm chuét ph¶i vµo líp ®ã  

 Trong  menu hiÖn ra chän Open Attribute Table 

 
 

B¶ng thuéc tÝnh sÏ ®−îc më 

 
 

  Thùc hμnh mét sè lÖnh t×m kiÕm, chän lùa ®èi t−îng 

trong ArcGis – lÖnh truy vÊn hái - ®¸p (Queries) 
 B¶n ®å trong ArcGis chøa ®ùng mét khèi l−îng lín th«ng tin. Tuy nhiªn, ®Ó 

b¶n ®å kh«ng trë nªn qu¸ phøc t¹p khi sö dông kh«ng ph¶i tÊt c¶ c¸c th«ng tin 
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nµy ®−îc thÓ hiÖn trùc quan trªn b¶n ®å. Arcgis cã mét sè c«ng cô ®Ó khai th¸c 

c¸c th«ng tin ®ã: c«ng cô Identify ®Ó tr¶ lêi c©u hái “§ã lµ c¸i g×”, c«ng cô Query 

®Ó t×m c¸c ®èi t−îng tho¶ m·n 1 hay nhiÒu ®iÒu kiÖn nµo ®ã hay ®Ó ph©n tÝch d÷ 

liÖu. 

           1. Lùa chän theo thuéc tÝnh cña ®èi t−îng 
+tõ thanh thùc ®¬n Selection chän  

Select by Attributes hoÆc ta chän tõ 

Option cña b¶ng thuéc tÝnh 

  + chän tr−êng cÇn lùa chän ë hép Fields 

+ chän phÐp tÝnh cña c©u lÖnh 

      + chän gi¸ trÞ g¸n cho tr−êng 

      + BÊm Apply c¸c ®èi t−îng ®−îc chän 

sÏ ®−îc hiÓn thÞ mµu xanh 

 

  

               C¸c ®èi t−îng ®−îc chän sÏ cã mµu xanh da trêi. B¹n cã thÓ thay ®æi 

mµu mÆc ®Þnh nµy qua ®−êng dÉn Selection > Option 

               NÕu muèn b¹n cã thÓ ghi c¸c ®èi t−îng ®· ®−îc chän thµnh mét layer 

míi hay xuÊt d÷ liÖu (export) thµnh mét shape field kh¸c. 

               Trong b¶ng thuéc tÝnh b¹n cã thÓ chØ hiÓn thÞ c¸c ®èi t−îng ®−îc chän. 

§Ó lµm ®−îc ®iÒu ®ã h·y bÊm vµo nót Selected nh− h×nh vÏ d−íi ®©y: 

 

          2. Lùa chän theo vÞ trÝ vµ mèi quan hÖ vÒ kh«ng gian gi÷a c¸c ®èi t−îng 

              Trong phÇn trªn chóng ta ®· nghiªn cøu c¸ch chän vµ t×m c¸c ®èi t−îng 

theo thuéc tÝnh cña chóng. Trong phÇn nµy chóng ta sÏ nghiªn cøu vÒ c¸ch chän 

®èi t−îng theo c¸c quan hÖ kh«ng gian cña chóng. Ch¶ng h¹n nh− t×m ®iÓm, 

®−êng vµ vïng n»m gÇn hay c¾t ngang c¸c ®èi t−îng ë mét layeer kh¸c. §Ó chän 

c¸c ®èi t−îng dùa theo vÞ trÝ ®Þa lý vµ mèi liªn hÖ vÒ kh«ng gian gi÷a chóng cã thÓ 

sö dông c«ng cô Select by Location ë menu Selection  
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             Mét sè mèi quan hÖ kh«ng gian sö dông trong c«ng cô Select by 

Location 

 Intersect: Chän c¸c ®èi t−îng giao nhau víi c¸c ®èi t−îng ë c¸c 

layer kh¸c 

 Are within a distance of: Chän c¸c ®èi t−îng n»m c¸ch c¸c ®èi 

t−îng ë layer kh¸c  trong ph¹m vi kho¶ng c¸ch cho tr−íc. §èi víi 

®−êng vµ vïng th× kho¶ng c¸ch ®−îc tÝnh theo c¹nh gÇn nhÊt hoÆc 

t©m cña chóng. 

 Complate contain: Chän c¸c ®èi t−îng chøa c¸c ®èi t−îng ë mét 

layer kh¸c. 

 Are complate within: Chän c¸c ®èi t−îng n»m bªn trong c¸c ®èi 

t−îng ë mét layer kh¸c 

 Have their centre in: Chän c¸c ®èi t−îng cã ®iÓm träng t©m ë bªn 

trong c¸c ®èi t−îng ë mét layer kh¸c 

 Share a line segment with: Chän c¸c ®èi t−îng cã cïng chung 

c¹nh hay ®Ønh víi ®èi t−îng ë mét layer kh¸c 

 Are identical to: Chän c¸c ®èi t−îng cã h×nh d¹ng, kÝch th−íc vµ vÞ 

trÝ gièng nh− c¸c ®èi t−îng ®· cho tr−íc  
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 Are containted by: Chän c¸c ®èi t−îng n»m trong c¸c ®èi t−îng cña 

Layer kh¸c. Kh¸c víi ph−¬ng ph¸p Are complate within, c¸c ®èi 

t−îng tiÕp xóc víi ®−êng bao ®−îc chän. 

 Are crossed by the outline of another feature : §©y lµ ph−¬ng 

pahsp chän c¸c ®èi t−îng bÞ c¾t bëi ®−êng bao cña c¸c ®èi t−îng ë 

layer kh¸c. 

            VÝ dô sau m« t¶ cho c¸c ph−¬ng ph¸p chän ®èi t−îng theo quan hÖ kh«ng 

gian cña chóng. Gi¶ thiÕt r»ng trªn b¶n ®å cña chóng ta cã 2 líp Layer 1 vµ 

Layer 2. Layer 1 cã 6 ®èi t−îng lµ A1  F1, Layer 2 cã 1 ®èi t−îng duy nhÊt M_2 

(M_2 cã ®−êng bao ®Ëm) NÕu chóng ta ®−a ra lÖnh:  

             Select feature from Layer 1 that …………. The feature in Layer 2 

 
             Th× tuú vµo ph−¬ng ph¸p chän ta cã c¸c kÕt qu¶ trong b¶ng sau ( dÊu X 

cã nghÜa lµ ®èi t−îng sÏ ®−îc chän). 
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     3. T¹o míi c¸c ®èi t−îng  

 - chän thùc ®¬n Tools - Editor ToolBar hoÆc View - Tool- Editor 

 

 - BÊm vµo nót Editor råi chän Start Editing ®Ó b¾t ®Çu biªn tËp 

 - BÊm tiÕp vµo nót Editor råi chän Snap Option trong cöa sæ hiÖn ra ®¸nh 

dÊu tÊt c¶ c¸c « ë cét Vertex ®Ó chän chÕ ®é b¾t ®iÓm vµo ®Ønh cña c¸c ®−êng vµ 

vïng. 

 - chän  c¸c c«ng cô trong biÓu t−îng  ®Ó vÏ c¸c ®èi t−îng. Sau khi vÏ 

xong ®èi t−îng chän lÖnh End Sketch th× c¸c ®èi t−îng míi cã trong CSDL. 

II. Lμm quen víi phÇn mÒm ArcCatalog 

 1. Khëi ®éng ArcCatalog: 

 cã 2 c¸ch ®Ó khëi ®éng ArcCatalog 

C¸ch 1: khëi ®éng tõ biÓu t−îng cña mµn h×nh  

C¸ch 2: chän Start           Program           ArcGis              

ArcCatalog 

 2. C¸c chÕ ®é hiÓn thÞ  

 ArcCatalog cung cÊp 3 c¸ch xem d÷ liÖu lµ: 

Contents, Preview, Metadata view.  
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 ChÕ ®é Contents view 

 - Chän Contents 

- tÊt c¶ c¸c d÷ liÖu ®−îc hiÓn thÞ d−íi d¹ng c©y th− môc hay c¸c biÓu t−îng 

 ChÕ ®é Preview  

- chän Preview 

- d÷ liÖu ®−îc hiÓn thÞ d−íi d¹ng b¶n ®å  

nÕu ta chän Geography trong hép tho¹i Preview  

hay d−íi d¹ng b¶ng nÕu chän Table 

- cã thÓ dïng  trªn thùc 

®¬n ®Ó phãng to, thu nhá, xem thuéc tÝnh ®èi 

t−îng  

+ trong chÕ ®é Metadata View d÷ liÖu ®−îc hiÓn thÞ ë d¹ng metadata tóc lµ 

c¸c th«ng tin m« t¶ kh¸c nhau vÒ d÷ liÖu nh− hÖ quy chiÕu, thêi gian vµ ph−¬ng 

ph¸p thu thËp 

3. T¹o míi d÷ liÖu  

 T¹o mét GeoDatabase 

 - chän ®−êng dÉn chøa GeoDatabase 

 - kÝch chuét ph¶i vµo chç bÊt kú trªn mµn h×nh 

 - Chän New  

 - chän Personal GeoDatabase 

 - §¸nh tªn cho GeoDatabase 

 T¹o míi mét Feature Dataset 

 - chän ®−êng dÉn chøa Feature Dataset 

 - kÝch chuét ph¶i vµo chç bÊt kú trªn mµn h×nh 

 - Chän New  

 - chän Feature Dataset 

 - §¸nh tªn cho Feature Dataset trong hép Name 

 - Chän Edit ®Ó ®Æt hÖ thèng to¹ ®é xuÊt hiÖn hép tho¹i 

 - Chän Select sau ®ã lùa chän hÖ thèng to¹ ®é 
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 - BÊm Apply 

 - BÊm OK 

III. Khëi ®éng ArcToolBox 

 Khëi ®éng Arc Toolbox 

 C¸ch 1: më ArcCatalog sau ®ã tÝch chuét vµo phÝm   

 C¸ch 2: më ArcMap sau ®ã tÝch chuét vµo phÝm  

 

 ArcToolbox cung cÊp c¸c thanh c«ng cô ®Ó 

chØnh söa d÷ liÖu: nh− xuÊt nhËp sang c¸c khu«n d¹ng 

d÷ liÖu, chång xÕp c¸c líp, xo¸ c¸c ®èi t−îng… 

  

 

 

 

Bμi tËp: 

 Khëi ®éng ArcMap thªm c¸c líp 01-dc01_dgn_Polygon, 01-

dc01_dgn_Point, 01-dc01_dgn_Annotation, 01-gt03_dgn_Polygon, 01-

gt03_dgn_Polyline vµo trong b¶n ®å  

 - ®æi mµu ë líp 18 cña  gt03_dgn_Polyline sang mµu 10 vµ chän kiÓu 

®−êng Colector Street 

 - T×m kiÕm tÊt c¶ c¸c ®èi t−îng trong líp 01-dc01_dgn_Polygon cã 

diÖn tÝch nhá h¬n 100m 

 - Xem thuéc tÝnh cña 1 vïng võa chän ®−îc 

 - lùa chän tÊt c¶ c¸c ®èi t−îng ë líp 01-dc01_dgn_Polygon chøa c¸c 

®èi t−îng ë líp 01-gt03_dgn_Polyline 
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PhÇn 2:    Lμm viÖc víi d÷ liÖu b¶ng trong ArcGis 

 
 Më b¶ng thuéc tÝnh cña líp 

 - kÝch chuét ph¶i vµo líp cÇn hiÖn b¶ng thuéc tÝnh 

 - chän Open Atribute Tables sÏ hiÓn thÞ b¶ng thuéc tÝnh nh− bªn 

 - chän All nÕu muèn hiÓn thÞ tÊt c¶ c¸c b¶ng ghi. Chän selected nÕu 

chØ muèn hiÓn thÞ c¸c b¶ng ghi ®∙ lùa chän 

 §Æt Font vµ kÝch th−íc ch÷  cho b¶ng 

 - chän Options > Appearance 

 - chän Font ch÷ trong mòi tªn cuén 

cña hép tho¹i Table Font 

 - chän kÝch th−íc ch÷ vµ mµu s¾c 

trong mòi tªn cuèn cña hép tho¹i Table 

Font Size and Color 

 - BÊm OK 

 

 

 

 §Æt Font ch÷ vµ mµu s¾c ch÷ mÆc ®Þnh 

cho tÊt c¶ c¸c b¶ng 

 - chän thùc ®¬n Tools 

 - chän Option 

 - Chän thanh Tables  

 - chän Font ch÷, mµu s¾c vµ kÝch th−íc 

ch÷ trong mòi tªn cuén 

 - BÊm OK 
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 Di chuyÓn tíi mét b¶ng ghi cô thÓ 

 - më b¶ng thuéc tÝnh 

 - ®¸nh sè cña b¶ng ghi muèn di chuyÓn tíi 

 - Ên Enter 

 

 

 Xem tÊt c¶ c¸c b¶ng ghi hoÆc xem mét 

b¶ng ghi ®−îc lùa chän 

 - më b¶ng thuéc tÝnh 

 - Chän All nÕu xem tÊt c¶ c¸c b¶ng ghi 

 - chän Selected nÕu chØ xem c¸c b¶ng ghi ®−îc 

lùa chän 

 T×m c¸c b¶ng ghi víi gi¸ trÞ thuéc tÝnh cô thÓ 

 - kÝch chuét vµo phÇn trªn cña cét 

chøa ch÷ muèn t×m kiÕm 

 - Chän Option 

 - chän Find and Replace 

 - ®¸nh gi¸ trÞ thuéc tÝnh cÇn t×m 

 - chän kiÓu t×m kiÕm trong mòi tªn 

cuén Text Match 

 - Chän Find Next 

 - BÊm Cancel 
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  S¾p xÕp c¸c Record theo mét thø tù nhÊt ®Þnh 

- kÝch chuét tr¸i vµo phÝa trªn cét cÇn 

s¾p xÕp nÕu muèn s¾p xÕp nhiÒu tr−êng Ên 

®ång thêi phÝm Ctrl 

 - chän Sort Ascending nÕu muèn s¾p 

xÕp theo chiÒu t¨ng dÇn 

 - chän Sort Descending nÕu muèn s¾p 

xÕp theo chiÒu gi¶m dÇn 

 

 Lùa chän theo thuéc tÝnh 

+tõ thanh thùc ®¬n Selection chän  

Select by Attributes hoÆc ta chän tõ 

Option cña b¶ng thuéc tÝnh 

  + chän tr−êng cÇn lùa chän ë hép 

Fields 

+ chän phÐp tÝnh cña c©u lÖnh 

      + chän gi¸ trÞ g¸n cho tr−êng 

      + BÊm Apply c¸c ®èi t−îng ®−îc chän 

sÏ ®−îc hiÓn thÞ mµu xanh 

 

  Lùa chän tÊt c¶ c¸c b¶ng ghi 

- chän Options trong b¶ng thuéc tÝnh 

- chän Select All 

 Xo¸ c¸c lùa chän ®· chän 

- Chän Options trong b¶ng thuéc tÝnh 

- Chän Clear Selection 
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  XuÊt b¶ng ghi 

- chän Option 

- chän Export 

- lùa chän kiÓu xuÊt theo b¶ng ghi lùa 

chän hay tÊt c¶ c¸c b¶ng ghi ë mòi tªn 

cuèn Export 

- kÝch chuét vµo  ®Ó chän ®−êng dÉn 

cho b¶ng 

- §¸nh tªn cho b¶ng ghi vµ chän Save 

- BÊm OK 

 TÝnh tæng cña d÷ liÖu trong mét tr−êng 

- kÝch chuét vµo phÇn trªn cña cét cÇn 

tÝnh tæng chän Sumarize  

- chän tr−êng cÇn tÝnh ë mòi tªn cuén 1 

- chän c¸c ph−¬ng ph¸p tÝnh cña 

tr−êng ë mòi tªn cuén 2 

- chän ®−êng dÉn vµ tªn cña b¶ng xuÊt 

ë nót  

- chän OK 

- chän Yes nÕu ®−a b¶ng ghi xuÊt ®−îc vµo b¶n ®å ®ang më 
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 Thùc hiÖn phÐp tÝnh trong mét tr−êng 

- kÝch chuét vµo Edit chän Start 

Editing 

- më b¶ng thuéc tÝnh cña líp cÇn thùc 

hiÖn phÐp tÝnh 

- kÝch chuét  ph¶i ë phÇn trªn cña cét cÇn 

tÝnh gi¸ trÞ chän Caculate Values… 

- sö dông Fields vµ Functions ®Ó 

thµnh lËp c©u lÖnh ®èi víi nh÷ng c©u lÖnh ®¬n gi¶n cã thÓ ®¸nh trùc tiÕp 

- chän OK 

 Thèng kª d÷ liÖu trong mét tr−êng 

- kÝch chuét ph¶i vµo phÇn trªn cña 

tr−êng cÇn thèng kÕ 

- chän Statistics 

- Sè liÖu thèng kª sÏ hiÖn ë b¶ng bªn 

 T¹o míi tr−êng 

 -  kÝch chuét vµo thùc ®¬n Option 

trong b¶ng thuéc tÝnh chän Add Field.. 

 - nhËp tªn tr−êng míi vµo hép 

tho¹i Name, kiÓu d÷ liÖu trong hép tho¹i 

Type, nhËp ®é réng cho tr−êng trong hép 

tho¹i Field Properties 

 - BÊm OK 
 

 Xo¸ tr−êng 

- kÝch chuét tr¸i vµo phÝa trªn tr−êng cÇn xo¸ 

- kÝch chuét ph¶i vµ chän Delete Field 
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 Thªm mét Records míi 

- kÝch chuét vµo Edit chän Start Editing 

- më b¶ng thuéc tÝnh cÇn thªm 

- di chuét xuèng b¶ng ghi cuèi 

- ®¸nh thªm c¸c thuéc tÝnh trong tõng cét 

 Xo¸ mét Record 

- chän Record cÇn xo¸ 

- BÊm phÝm Delete trªn bµn phÝm 

 G¾n nhËp hai b¶ng thuéc tÝnh thµnh mét 

VD: g¾n kÕt d÷ liÖu trong file b7_th05 (file ®Ých).sh vµ b7_th09(file 

nguån) 

- kÝch chuét ph¶i vµo líp b7_th05 chän 

Join 

- chän  liªn kÕt theo thuéc tÝnh Join 

attribute from a table 

- chän tr−êng ®Ó sö dông liªn kÕt 

- chän file nguån 

- chän tr−êng cña file nguån ®Ó liªn kÕt 

- BÊm OK 

          - Khi ®ã trong b¶ng d÷ liÖu cña file 

b7_th05 , ngoµi c¸c field cã s½n (ObjectID, Shape, Maloai,Shape_length) sÏ 

xuÊt hiÖn thªm c¸c field cña file b7_th09 . Chó ý, c¸c tr−êng míi nµy chØ 

mang tÝnh chÊt hiÓn thÞ, kh«ng l−u tr÷ trong c¬ së d÷ liÖu cña file b7_th05. 

          - muèn l−u tr÷ thªm tr−êng nµo cña file b7_th09 ta ph¶i t¹o thªm 

tr−êng míi.  
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 Thùc hμnh:Thªm tr−êng ®é réng vµo trong b7_th05 

           - t¹o tr−êng míi cã thuéc tÝnh cã tªn Dorong, kiÓu ShortInteger vµ cã 

®é réng lµ 5 

          - tÝnh to¸n Caculate.. tõ sè liÖu cña b7_th09 

          - chän Stop Editing ®Ó l−u d÷ liÖu 

          - xo¸ d÷ liÖu ®∙ liªn kÕt chän Join>chän Remove Join 

 Bμi tËp vÒ nhμ 

 Më b¶ng thuéc tÝnh cña líp b7_tv03 

 - trong tr−êng Noidung nhËp thªm c¸c « cßn thiÕu lµ trµm 

 - Xãa tr−êng Cochu, Gocquay 

 - Thªm tr−êng Maloai d¹ng ShortInteger vµ ®é réng lµ 5 

 -TÝnh to¸n gi¸ trÞ thuéc tÝnh cho tr−êng Maloai theo tr−êng Néidung 

nh− sau: 

Noidung Maloai

V−ên quèc gia U Minh Th−îng 752 

mÝa 7533 

B¹ch ®µn 7532 

Xoµi, æi, mËn 7531 

®−íc, trµm 7534 
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PhÇn  3: Lμm viÖc víi Map Projection trong ArcGIS 
 

3.1. Lùa chän  phÐp chiÕu cho b¶n ®å. 

1) Lùa chän l−íi chiÕu b¶n ®å. 
 
 BÊm chuét ph¶i vµo Data Frame mµ b¹n muèn x¸c ®Þnh l−íi chiÕu 

 Lùa chän Properties 

 Trªn hép tho¹i Data Frame Properties chän 

Coordinate System 

 BÊm chuét vµo Predefined 

 Lùa chän phÐp chiÕu mµ b¹n muèn biÓu thÞ  

 Ên ok 

Sau khi b¹n lùa chän phÐp chiÕu th× tÊt c¶ c¸c layer trong Data Frame sÏ ®−îc 

biÓu thÞ theo l−íi chiÕu ®ã. 

 

 

 

 

 
2) Thay ®æi th«ng sè cña hÖ to¹ ®é 

 BÊm chuét ph¶i vµo Data Frame mµ b¹n muèn x¸c ®Þnh l−íi chiÕu 

 Lùa chän Properties 

 Trªn hép tho¹i Data Frame Properties chän 

Coordinate System 

 BÊm chuét vµo Modify 

 Ban cã thÓ thay ®æi c¸c th«ng sè cña l−íi chiÕu 

trªn hép tho¹i Projected Coordinate System 

Properties 

 Sau ®ã bÊm ok 

 TiÕp tôc bÊm ok trªn hép tho¹i Data Frame 
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Properties 

3) Lùa chän ®¬n vÞ ®é dµi  

Khi b¹n muèn tÝnh to¸n kho¶ng c¸ch gi÷a c¸c ®iÓm hay x¸c ®Þnh vÞ trÝ cña mét 

®iÓm trªn b¶n ®å, b¹n cÇn ph¶i lùa chän ®¬n vÞ ®o. B¹n cã thÓ thay ®æi ®¬n vÞ ®o 

bëi sù thay ®æi hÖ to¹ ®é 

 BÊm chuét ph¶i vµo Data Frame mµ b¹n muèn x¸c ®Þnh l−íi chiÕu 

 Lùa chän Properties 

 BÊm chuét vµo thanh General 

 BÊm chuét vµo thanh Map vµ lùa chän ®¬n vÞ phï hîp 

 BÊm chuét vµo thanh Display vµ lùa chän ®¬n vÞ phï hîp 

 Lùa chän OK 
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PhÇn 4:   Sè ho¸ b¶n ®å quÐt trong ArcGis 

 
 C¸c c«ng cô sè ho¸ ®èi t−îng  

 
+ Sketch Tools: vÏ ®iÓm, ®−êng hoÆc vïng 

+ Intersect Tools: cho phÐp t¹o mét ®Ønh tõ giao cña 2 ®èi t−îng kh¸c 

+ Tangent Curve tool: vÏ mét cung víi ®iÓm b¾t ®Çu lµ ®iÓm cuèi cña 

mét ®o¹n th¼ng 

+ Arc Tool: vÏ cung 

+ Midpoint Tool: chän ®iÓm b¾t ®Çu lµ ®iÓm gi÷a cña 2 ®iÓm kh¸c 

+ End point ArcTool: 

+ Distance – Distance Tool: cho phÐp t¹o mét ®iÓm hoÆc mét ®Ønh tõ 

kho¶ng c¸ch cña 2 ®èi t−îng kh¸c 

- chän ®iÓm thø nhÊt 

- Ên phÝm D ®Ó x¸c ®Þnh b¸n kÝnh cña vßng trßn thø nhÊt 

- chän ®iÓm thø hai 

- Ên phÝm D ®Ó x¸c ®Þnh chÝnh x¸c b¸n kÝnh cña vßng trßn thø hai 

- giao cña 2 vßng trßn lµ ®iÓm cÇn x¸c ®Þnh 

- chän c«ng cô vÏ kh¸c ®Ó vÏ tiÕp ®èi t−îng 

 + Direction – Distance Tool: cho phÐp t¹o mét ®iÓm hoÆc mét ®Ønh 

theo h−íng cña ®èi t−îng thø 1 víi kho¶ng c¸ch víi ®èi t−îng thø 2 

- chän ®iÓm thø nhÊt 

- Ên phÝm R ®Ó x¸c ®Þnh h−íng cña ®−êng th¼ng 

- chän ®iÓm thø hai 

- Ên phÝm D ®Ó x¸c ®Þnh chÝnh x¸c b¸n kÝnh cña vßng trßn  

- giao cña ®−êng th¼ng vµ vßng trßn lµ ®iÓm cÇn x¸c ®Þnh 

- chän c«ng cô vÏ kh¸c ®Ó vÏ tiÕp ®èi t−îng 
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 + Trace: T¹o mét ®èi t−îng theo h−íng cña  mét ®èi t−îng ®∙ ®−îc 

vÏ 

 C¸c ph−¬ng ph¸p nhËp ®iÓm  

 - Absolute X,Y: nhËp theo to¹ ®é tuyÖt ®èi cña ®iÓm 

 - Delta X, Y: nhËp theo to¹ ®é t−¬ng ®èi cña ®iÓm nµy so víi ®iÓm 

kh¸c 

 - Direction/Length: nhËp theo h−íng vµ ®é dµi  

 - Parallel: lÊy theo h−íng song song 

 - Defection: ®Æt gãc cè ®Þnh theo mét c¹nh ®ang vÏ 

 - Length: ®Æt theo chiÒu dµi cè ®Þnh  

 

Bµi tËp: sö dông c¸c thanh c«ng cô ®Ó vÏ h×nh sau: 

 
1. T¹o l−íi km 

- Nèi 4 ®iÓm gãc khung t¹o thµnh 4 c¹nh cña khung. 

- Copy c¸c c¹nh cña khung ®Ó t¹o thµnh  c¸c ®−êng l−íi Km 

trong khung. 
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VÏ khung l−íi km cã To¹ ®é cña 4 ®iÓm gãc khung nh− sau 

  xy=542500,313500 

  xy=543000,313500 

  xy=543000,313000 

  xy=542500,313000 

2. N¾n b¶n ®å 

 Më c«ng cô ®Ó n¾n ¶nh 

- Vµo thùc ®¬n Tools > Customizes>Toolbars>Georeferencing 

 Më file ¶nh cÇn n¾n 

 - KÝch chuét ph¶i vµo biÓu t−îng  

 - chän Add Data 

 - T×m ®−êng dÉn cho file ¶nh 

 - BÊm Add 

- §Ó hiÓn thÞ ¶nh ®óng h−íng chän 

Georeferencing> Flip or Rotate 

+ Rotate Right: quay  ¶nh theo chiÒu ph¶i 

+ Rotate Left: quay ¶nh theo chiÒu tr¸i 

+ Flip Horizontal: 

+ Flip Vertical: 

- chän Fit to Display ®Ó hiÓn thÞ ¶nh võa mµn h×nh 

 N¾n ¶nh 

- Vµo thùc ®¬n Tools > Customizes>Toolbars>Georeferencing 

- më l−íi km ®∙ t¹o 

- kÝch chuét vµo biÓu t−îng  ®Ó thªm ®iÓm 

n¾n 

- kÝch vµo biÓu t−îng  ®Ó xem sai sè n¾n ¶nh. 

KÕt qu¶ hiÓn thÞ ë b¶ng bªn 

- BÊm Save ®Ó l−u kÕt qu¶ n¾n 

- Chän ®−êng dÉn cho File kÕt qu¶ 

- ®Æt tªn cho File kÕt qu¶ vµ chän OK 

- BÊm OK 
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3. Sè ho¸ c¸c ®èi t−îng trªn nÒn ¶nh  

 Më file ¶nh n¾n 

- KÝch chuét ph¶i vµo biÓu t−îng  

- chän Add Data 

- T×m ®−êng dÉn cho file ¶nh n¾n 

- kÝch chuét vµo biÓu t−îng  trªn thanh c«ng cô Georeferencing 

- chän Load 

- BÊm OK 

 Vector ho¸ ®èi t−îng d¹ng ®−êng 

- trong mòi tªn cuén cña hép tho¹i Target chän líp chøa ®èi t−îng 

d¹ng ®−êng 

- kÝch chuét vµo Editor chon Start Editing 

- chän mét trong c¸c thanh c«ng cô sè ho¸ ®Ó sè ho¸ c¸c ®èi t−îng 

d¹ng ®−êng 

- NhËp th«ng tin thuéc tÝnh cho c¸c ®èi t−îng theo b¶ng sau 

 

 Vector ho¸ ®èi t−îng d¹ng vïng 

- trong mòi tªn cuén cña hép tho¹i Target chän líp chøa ®èi t−îng 

d¹ng vïng 

- kÝch chuét vµo Editor chän Start Editing 

- chän mét trong c¸c thanh c«ng cô sè ho¸ ®Ó sè ho¸ c¸c ®èi t−îng 

d¹ng vïng 

 

 Vector ho¸ ®èi t−îng d¹ng ®iÓm 

- trong mòi tªn cuén cña hép tho¹i Target chän líp chøa ®èi t−îng 

d¹ng ®iÓm 

- kÝch chuét vµo Editor chän Start Editing 

Name Type 
Width Precision 

Ten duong String 30 0 

Loai duong String 30 0 

Chieudai Number 9 3 
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- chän mét trong c¸c thanh c«ng cô sè ho¸ ®Ó sè ho¸ c¸c ®èi t−îng 

d¹ng ®iÓm 

 

4. C¸c c«ng cô chØnh söa d÷ liÖu ®å ho¹ 

 C¾t ®−êng th¼ng thµnh c¸c phÇn  

- chän ®èi t−îng cÇn c¾t 

- chän  

- chän vÞ trÝ trªn ®−êng cÇn t¸ch 

 C¾t ®−êng th¼ng theo kho¶ng c¸ch hoÆc tû lÖ x¸c ®Þnh 

- chän thanh Edit tool 

- chän vµo ®−êng th¼ng cÇn c¾t 

- chän Editor > Split 

- chän Distance along the line nÕu muèn c¾t theo kho¶ng c¸ch x¸c ®Þnh 

- chän Percentage of the line length nÕu c¾t theo tû lÖ phÇn tr¨m 

- ®¸nh vµo gi¸ trÞ kho¶ng c¸ch hoÆc tû lÖ phÇn tr¨m 

- chän From Start Point of Line nÕu c¾t ®èi t−îng tõ ®iÓm ®Çu 

- chän From End Point of Line nÕu c¾t ®èi t−îng tõ ®iÓm cuèi 

- chän OK 

 C¾t mét polygon 

- chän Edit tool 

- chän polygon muèn c¾t 

- trong mòi tªn ®æ xuèng cña Task chän chÕ ®é Cut polygon Features 

- chän Sketch tool ®Ó vÏ ®−êng hoÆc vïng lµm c¬ së ®Ó chia vïng võa 

chän 

- kÝch chuét ph¶i vµo bÊt kú ®iÓm nµo trªn mµn h×nh  

- chän Finish Sketch 

 C¾t ®o¹n th¼ng cã mét ®é dµi nhÊt ®Þnh tõ ®iÓm cuèi 

- chän chøc n¨ng Modify Feature trong mòi tªn ®æ cña Task 

- chän Edit tool 

- chän ®−êng th¼ng muèn c¾t 

- kÝch chuét ph¶i vµo bÊt cø phÇn nµo cña ®−êng chän Trim to Length 

- ®¸nh vµo chiÒu dµi míi cña ®−êng 
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- chän Finish Sketch 

 C¾t/ kÐo dµi  dùa vµo mét ®−êng ®−îc vÏ 

- Chän Extend/Trim Features trong thanh cuén xuèng cña Task 

- chän Edit tool 

- chän mét ®−êng hoÆc nhiÒu ®−êng muèn c¾t 

- chän Sketch tool vÏ ®−êng míi 

- kÝch chuét ph¶i chän Finish Sketch 

 §Æt ®iÓm däc theo mét ®−êng th¼ng 

- chän Edit tool 

- chän ®−êng muèn chia 

- chän líp muèn chøa ®iÓm ®−îc ®Æt trong thanh cuén xuèng cña hép 

tho¹i Target 

- chän Editor > Divede 

- chän Place vµ ®¸nh sè ®iÓm sÏ ®−îc ®Æt trªn ®−êng ®∙ chän 

- chän OK 

 Thay ®æi ®Ønh cña ®−êng hoÆc vïng 

- chän Reshape Feature trong mòi tªn cuén cña hép 

tho¹i Task 

- chän Edit tool 

- chän ®èi t−îng muèn thay ®æi 

- chän Sketch tool 

- vÏ 1 ®−êng dùa theo c¸ch muèn thay ®æi ®Ønh 

cña ®èi t−îng 

- kÝch chuét ph¶i vµo chç bÊt kú mµn h×nh 

chän Finish Sketch 

 

 Thªm ®Ønh cña mét ®−êng hoÆc mét vïng 

- chän Modify Feature trong mòi tªn cuén cña hép tho¹i Task 

- chän Edit tool 

- chän ®uêng hoÆc vïng muèn thªm ®Ønh 

- kÝch chuét ph¶i chän Insert Vertex 

- chän Finish Sketch 
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 Xo¸ ®Ønh cña ®−êng hoÆc vïng 

- chän Modify Feature trong mòi tªn cuén cña hép tho¹i Task 

- chän Edit tool 

- chän ®−êng hoÆc vïng muèn xo¸ ®Ønh 

- ®−a chuét ®Õn ®Ønh cÇn xo¸ 

- kÝch chuét ph¶i chän Delete Vertex 

- chän Finish Sketch 

 KÐo ®Ønh cña ®−êng hoÆc vïng 

- chän Modify Feature trong mòi tªn cuén cña hép tho¹i Task 

- chän Edit tool 

- chän ®−êng hoÆc vïng muèn thay ®æi ®Ønh 

- ®−a chuét ®Õn ®Ønh cÇn xo¸ vµ kÐo ra vÞ trÝ míi 

- chän Finish 

 Di chuyÓn ®Ønh ®Õn mét to¹ ®é x¸c ®Þnh 

- chän Modify Feature trong mòi tªn cuén cña hép tho¹i Task 

- chän Edit tool 

- chän ®−êng hoÆc vïng muèn di chuyÓn ®Ønh 

- ®−a chuét ®Õn ®Ønh cÇn di chuyÓn  

- kÝch chuét ph¶i chän Move to 

- ®¸nh gi¸ trÞ to¹ ®é míi cho ®Ønh 

- chän Finish Sketch 

 Di chuyÓn ®Ønh theo vÞ trÝ t−¬ng ®èi cña nã 

- chän Modify Feature trong mòi tªn cuén cña hép tho¹i Task 

- chän Edit tool 

- chän ®−êng hoÆc vïng muèn di chuyÓn ®Ønh 

- ®−a chuét ®Õn ®Ønh cÇn di chuyÓn  

- kÝch chuét ph¶i chän Move 

- ®¸nh gi¸ trÞ t−¬ng ®èi x, y cña ®Ønh míi so víi ®Ønh cò 

- chän Finish Sketch 

 Thªm mét ®Ønh ë gi÷a mét ®o¹n ®∙ cã 

- chän chuét ph¶i vµo ®o¹n cÇn thªm ®Ønh chän Properties 

- chän ®Ønh ®Ó thªm ®Ønh vµo tr−íc nã 
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- kÝch chuét ph¶i vµo ®Ønh ®∙ chän chän Insert  Before 

5. ChØnh söa d÷ liÖu thuéc tÝnh 

 - chän líp th«ng tin cÇn chØnh söa  

 - më b¶ng thuéc tÝnh 

 - chän Editor vµ chän Start Editing 

 - chän vµo « cÇn thay ®æi 

 - chän Save Edit ®Ó l−u l¹i kÕt qu¶ võa chØnh söa 

NhËp d÷ liÖu tõ c¸c phÇn mÒm kh¸c vμo ArcGis 
 ARCGis t−¬ng thÝch víi c¸c ®Þnh d¹ng sau: 

 - C¸c ®Þnh d¹ng CAD: *.dwg, *.dxf cña AutoCAD, *.dgn cña 

Microstation. 

 - ®Þnh d¹ng *.tab cña MapInfo 

 - File text chøa to¹ ®é X, Y cña c¸c ®èi t−îng d¹ng ®iÓm 

 §Ó thay ®æi ®Þnh d¹ng cña c¸c d÷ liÖu kh¸c ta sö dông c¸c thanh c«ng 

cô cña ArcToolBox ®Ó chuyÓn ®æi. 

 Khi chuyÓn d÷ liÖu tõ c¸c file ®Þnh d¹ng kh¸c sang ArcGis ta cÇn ph¶i 

chuyÓn lÇn l−ît tõng lo¹i ®èi t−îng vµo riªng tõng shapefile hay feature 

class 

 Më mét file *.dgn hoÆc *.dxf 

 - chän Add Data 

 - chän ®−êng dÉn cña file 

 - chän OK 

 ChuyÓn ®Þnh d¹ng tõ file *.dgn hoÆc *.dxf sang d¹ng *.shp 

 - khëi ®éng phÇn mÒm ArcToolbox 

 - chän Conversion Tools > To 

Shapefile> Feature Class To Shapefile 

 - chän file dgn cÇn thay ®æi trong 

thanh Browse cña hép tho¹i Input Features 

 - chän ®−êng dÉn cña shapefile trong 

thanh Browse cña hép tho¹i Output Folder 

 - bÊm OK 
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PhÇn 5: C¸c chøc n¨ng truy vÊn, ®o ®¹c vμ  

chång xÕp kh«ng gian 
 

1. C¸c chøc n¨ng ®o ®¹c kh«ng gian 

 §Æt ®¬n vÞ hiÓn thÞ gi¸ trÞ ®o ®¹c 

- kÝch chuét ph¶i vµo Layer chän tab General 

- chän ®¬n vÞ cho b¶n ®å vµ ®¬n vÞ hiÓn thÞ cho b¶n ®å trong hép 

tho¹i Uiits 

- chän Apply 

- chän OK 

 §o ®¹c ®èi t−îng ®−êng 

- Sö dông c«ng cô ®o kho¶ng c¸ch 

-  chän c«ng cô  trªn thanh c«ng cô Tools 

- chän ®iÓm ®Çu vµ ®iÓm cuèi cña ®o¹n th¼ng cÇn ®o 

- kÕt qu¶ ®−îc hiÓn thÞ ë thanh tr¹ng th¸i phÝa d−íi 

- trong ®ã:  segment:  gi¸ trÞ chiÒu dµi ®o¹n cuèi cïng 

  total:gi¸ trÞ tæng chiÒu dµi 

2. Chøc n¨ng truy vÊn kh«ng gian 

 Truy vÊn theo d÷ liÖu ®å häa 

- chän  trong hép tho¹i Tools 

- kÕt qu¶ truy vÊn sÏ ®−îc hiÓn thÞ trong b¶ng Identify Result 

 Truy vÊn theo th«ng tin thuéc tÝnh 

- khëi ®éng phÇn mÒm ArcToolbox 

- chän Extract 

- chän Select 

- chän ®−êng dÉn cho File nguån b»ng 

thanh Browse cña hép tho¹i Input Feature 

- chän ®−êng dÉn cho File xuÊt b»ng 

thanh Browse cña hép tho¹i Output 

Feature 

- X©y dùng c©u lÖnh SQL 
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- c¸c ®èi t−îng tho¶ m∙n yªu cÇu ®−îc hiÓn thÞ trong file Output 

 C¸c truy vÊn dùa trªn c¸c mèi quan hÖ kh«ng gian 

             Mét sè mèi quan hÖ kh«ng gian sö dông trong c«ng cô Select by 

Location 

 Intersect: Chän c¸c ®èi t−îng giao nhau víi c¸c ®èi t−îng ë c¸c 

layer kh¸c 

 Are within a distance of: Chän c¸c ®èi t−îng n»m c¸ch c¸c ®èi 

t−îng ë layer kh¸c  trong ph¹m vi kho¶ng c¸ch cho tr−íc. §èi 

víi ®−êng vµ vïng th× kho¶ng c¸ch ®−îc tÝnh theo c¹nh gÇn 

nhÊt hoÆc t©m cña chóng. 

 Complate contain: Chän c¸c ®èi t−îng chøa c¸c ®èi t−îng ë 

mét layer kh¸c. 

 Are complate within: Chän c¸c ®èi t−îng n»m bªn trong c¸c ®èi 

t−îng ë mét layer kh¸c 

 Have their centre in: Chän c¸c ®èi t−îng cã ®iÓm träng t©m ë 

bªn trong c¸c ®èi t−îng ë mét layer kh¸c 

 Share a line segment with: Chän c¸c ®èi t−îng cã cïng chung 

c¹nh hay ®Ønh víi ®èi t−îng ë mét layer kh¸c 

 Are identical to: Chän c¸c ®èi t−îng cã h×nh d¹ng, kÝch th−íc vµ 

vÞ trÝ gièng nh− c¸c ®èi t−îng ®∙ cho tr−íc  

 Are containted by: Chän c¸c ®èi t−îng n»m trong c¸c ®èi t−îng 

cña Layer kh¸c. Kh¸c víi ph−¬ng ph¸p Are complate within, c¸c 

®èi t−îng tiÕp xóc víi ®−êng bao ®−îc chän. 

 Are crossed by the outline of another feature : §©y lµ ph−¬ng 

pahsp chän c¸c ®èi t−îng bÞ c¾t bëi ®−êng bao cña c¸c ®èi 

t−îng ë layer kh¸c. 

            VÝ dô sau m« t¶ cho c¸c ph−¬ng ph¸p chän ®èi t−îng theo quan hÖ 

kh«ng gian cña chóng. Gi¶ thiÕt r»ng trªn b¶n ®å cña chóng ta cã 2 líp 

Layer 1 vµ Layer 2. Layer 1 cã 6 ®èi t−îng lµ A1  F1, Layer 2 cã 1 ®èi t−îng 

duy nhÊt M_2 (M_2 cã ®−êng bao ®Ëm) NÕu chóng ta ®−a ra lÖnh:  

             Select feature from Layer 1 that …………. The feature in Layer 2 
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             Th× tuú vµo ph−¬ng ph¸p chän ta cã c¸c kÕt qu¶ trong b¶ng sau ( 

dÊu X cã nghÜa lµ ®èi t−îng sÏ ®−îc chän). 

             
 

3. Chøc n¨ng chång xÕp 

 Chång xÕp kh«ng gian sö dông chøc n¨ng INTERSECT 

Giao nhau gi÷a c¸c ®èi t−îng trªn 2 líp kh¸c nhau 

t¹o thµnh nhiÒu ®èi t−îng míi cã tÊt c¶ c¸c thuéc 

tÝnh cña 2 layer 

- 

 Chång xÕp kh«ng gian sö dông chøc n¨ng UNION 
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Giao nhau gi÷a c¸c ®èi t−îng trªn 2 líp kh¸c nhau 

t¹o thµnh nhiÒu ®èi t−îng míi (nhá h¬n) cã tÊt c¶ 

c¸c thuéc tÝnh cña 2 layer 

 - khëi ®éng ArcToolbox 

 - chän Analysist tool>Overlay>Union 

 - chän file ®Çu vµo trong mòi tªn cuén cña hép tho¹i Input feature 

 - chän file ®Çu ra b»ng thanh Browse cña hép tho¹i Output Feature 

 - chän OK 

 Sö dông chøc n¨ng DISSOLVE 

chËp c¸c ®èi t−îng kÒ nhau cã cïng chung mét 

thuéc tÝnh nµo ®ã thµnh ®èi t−îng duy nhÊt 

 

- khëi ®éng ArcToolbox 

 -  chän DataManagement tool> Generalization>Disslove 

 - chän file ®Çu vµo trong mòi tªn cuén cña hép tho¹i Input feature 

 - chän file ®Çu ra b»ng thanh Browse cña hép tho¹i Output Feature 

 - chän tr−êng thuéc tÝnh trong hép tho¹i Dissolve Fields 

 - chän OK 

 Sö dông chøc n¨ng MERGE 

ChËp 2 hay nhiÒu líp b¶n ®å thµnh mét líp duy 

nhÊt. C¸c thuéc tÝnh cã chung trong tÊt c¶ c¸c 

layers ®Çu vµo sÏ ®−îc gi÷ nguyªn.  

 - chän 2 ®èi t−îng cÇn Merge 

 - vµo thùc ®¬n Editor 

 - chän Merge 

 Chøc n¨ng t¹o Buffer 

- chän Proximity > chän 

Buffer 

- chän ®−êng dÉn cho file cÇn t¹o 

vïng ®Öm ë thanh Browse cña 

hép tho¹i Input Features 
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- chän ®−êng dÉn cho file chøa vïng ®Öm ë thanh Browse cña hép tho¹i 

Output Feature class 

- chän ®¬n vÞ vµ ®é réng kho¶ng ®Öm trong hép tho¹i Linear unit 

 C¾t Clip 

C¾t c¸c ®èi t−îng cña Input layer chØ gi÷ l¹i phÇn n»m trong ®−êng bao 

cña c¸c ®èi t−îng ë Clip layer 

- chän Extract > chän Clip 

- chän ®−êng dÉn cho file chøa ®èi 

t−îng sÏ ®−îc c¾t 

- chän ®−êng dÉn cho file chøa ®èi 

t−îng c¾t 

- chän ®−êng dÉn cho file chøa kÕt qu¶ 

- bÊm OK 
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PhÇn 7:  Tr×nh bμy in b¶n ®å hμnh chÝnh 
 

1. ChuÈn bÞ d÷ liÖu 

2. ChuÈn bÞ nÒn c¬ së to¸n häc cho trang tr×nh bµy ®Ó biªn tËp 

3. Biªn tËp c¸c ®èi t−îng d¹ng ®iÓm 

4. Biªn tËp c¸c ®èi t−îng d¹ng ®−êng 

5. Biªn tËp c¸c ®èi t−îng d¹ng vïng 

6. G¸n nh·n c¸c ch÷ ghi chó 

7. T¹o trang in vµ biªn tËp trªn trang in 

 ChuyÓn sang trang in 

- Vµo View chän Layout View 

 C¸ch t¹o trang in vµ lùa chän khæ giÊy 

- KÝch chuét ph¶i vµo trang in  

- chän Page and Print setup 

- chän m¸y in trong mòi tªn ®æ cña 

hép tho¹i Printer Setup 

- chän khæ giÊy trong hép tho¹i Paper 

- chän ®¬n vÞ trong hép tho¹i Page 

- chän OK 

 

 

 Biªn tËp b¶n ®å in 

- §Æt tØ lÖ cho b¶n ®å in 

 -  

- T¹o khung ngoµi cho b¶n ®å in 

 - KÝch chuét ph¶i vµo Data Frame chän 

Properties 

 - chän tab Frame 

 - kÝch vµo mòi tªn ®æ cña hép tho¹i 

Border ®Ó chän khung cho b¶n ®å in 
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 - chän mµu nÒn trong hép tho¹i Background 

 - chän mµu ®¸nh bãng trong hép tho¹i Drop Shadow 

 - chän Apply 

 Biªn tËp tªn b¶n ®å 

 Biªn tËp th−íc tû lÖ 

- Vµo thùc ®¬n Insert chän Scale Bar 

-  chän kiÓu th−íc tû lÖ cã s½n 

 Biªn tËp ký hiÖu chØ h−íng 

 Biªn tËp b¶ng chó gi¶i 

 Biªn tËp b¶ng biÓu vµ ®å thÞ 

 In b¶n ®å 

using ArcMap 

 


